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1. About this manual

1.1. Copyrights
The information in this document is subject to change without notice and should not 
be construed as a commitment by ABB Oy. ABB Oy assumes no responsibility for 
any errors that may appear in this document.

In no event shall ABB Oy be liable for direct, indirect, special, incidental or 
consequential damages of any nature or kind arising from the use of this document, 
nor shall  ABB Oy be liable for incidental or consequential damages arising from 
use of any software or hardware described in this document.

This document and parts thereof must not be reproduced or copied without written 
permission from ABB Oy, and the contents thereof must not be imparted to a third 
party nor used for any unauthorized purpose.

The software or hardware described in this document is furnished under a license 
and may be used, copied, or disclosed only in accordance with the terms of such 
license.

Copyright © 2005 ABB Oy 
All rights reserved.

1.2. Trademarks
ABB is a registered trademark of ABB Group.
All other brand or product names mentioned in this document may be trademarks or 
registered trademarks of their respective holders.

1.3. General
Connectivity package is a collection of software and information related to a specific 
protection and control terminal (IED). It provides means for applications and tools 
to connect and interact with IED.

This manual introduces the installation and uninstallation of the connectivity 
packages and the main functions of the Connectivity Package Manager. 
Connectivity Package Manager is a tool that helps the user to associate the right 
connectivity package versions to different applications and tools. This manual 
introduces also shortly the content and the usage of the connectivity packages as 
well as logical node naming principles.

For more information on handling connectivity packages in different applications 
and tools, refer to Section 1.8. Related documents.

This manual applies to the following connectivity packages: 

� REF 541/543/545 Connectivity Package v.1.1 and v. 1.2
� REM 543/545 Connectivity Package v. 1.1
� RET 541/543/545 Connectivity Package v. 1.0
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Supported IEDs:

� REF 541, REF 543, REF 545: Release 3.0, 3.5
� REM 543, REM 545: Release 2.5
� RET 541, RET 543, RET 545: Release 3.0

Connectivity packages support IEC 61850, LON and SPA communication protocols 
for the IEDs mentioned above.

Supported system products and tools:

� Communication Engineering Tool for COM 610
� Communication Engineering Tool for SPA-ZC 40x
� Communication Engineering Tool for MicroSCADA Pro SYS 600 *9.0 or later 

and COM 500 *4.1 or later
� SCL Importer in MicroSCADA Pro SYS 600 *9.1 or later and COM 500 *4.2 or 

later

For more information about the supported tools, refer to Chapter 4. Content and 
usage of connectivity packages.

This user�s guide is divided into following sections:

Installation and uninstallation
This chapter describes the installation and the uninstallation of the connectivity 
packages.

Connectivity Package Manager
This chapter introduces the funtionality of the Connectivity Package Manager and 
the handling of the connectivity packages.

Content and usage of connectivity packages
This chapter describes the content and usage of connectivity packages in different 
products.

Logical node naming
In this chapter you find the naming of logical nodes and the LN prefixes for RED500 
IEDs.

1.4. Use of symbols
The information symbol points out safety related or other important information. It 
also point out useful hints to the reader. The corresponding symbol should be 
interpreted as follows:

Information icon alerts the reader to pertinent facts and conditions.
6
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1.5. Document conventions
The following conventions are used for the presentation of material:

� The words in names of screen elements (for example, the title in the title bar of a 
window, the label for a field of a dialog box) are initially capitalized.

� Capital letters are used for the name of a keyboard key if it is labeled on the 
keyboard. For example, press the CTRL key. Enter and Shift keys are exceptions, 
for example, press Enter.

� Lowercase letters are used for the name of a keyboard key that is not labeled on 
the keyboard. For example, the space bar, comma key and so on.

� Press CTRL+C indicates that you must hold down the CTRL key while pressing 
the C key (to copy a selected object in this case).

� Press ESC E C indicates that you press and release each key in sequence (to copy 
a selected object in this case).

� The names of push and toggle buttons are boldfaced. For example, click OK.
� The names of menus and menu items are boldfaced. For example, the File menu.

� The following convention is used for menu operations: Menu Name > 
Menu Item > Cascaded Menu Item. For example: select File > Open > 
New Project.

� The Start menu name always refers to the Start menu on the Windows Task 
Bar.

� The menus that are displayed by right-clicking the mouse button are called 
shortcut menus.
7
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1.6. Terminology

Term Description

applications and tools In this context an application means a product that 
administer one of the supported tool, for example 
COM 610. A tool means one of the supported tool that are 
listed in Section 1.3. General, for example CET.

Communication 
Engineering Tool

Communication Engineering Tool is a software for 
configuring and monitoring communication gateways or 
communication front-ends.

connectivity concept The connectivity concept separates the IED specific 
information from applications and tools, it provides means 
for the user to update the applications and tools easily with 
the latest versions of the IED specific information.

connectivity package Software package that provides device specific information 
about certain protection and control relay (IED), which 
provides means for applications and tools to connect and 
interact with the IED. Furthermore, connectivity package 
will ease and simplify the engineering process.

Connectivity Package 
Manager

Software that helps user to associate right connectivity 
package versions to different applications and tools.

Intelligent Electronic 
Device

In this context, IED is used as a common term for 
protection and control relays, such as REF 543.

IEC 61850 A communication protocol based on IEC 61850 standard 
series and a standard for substations modeling.

Substation Configuration 
description Language 
(SCL)

XML based description language for configurations of 
electrical substation IEDs. Defined in the IEC 61850 
standard.
8
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1.7. Abbreviations
The following is a list of abbreviations associated with connectivity packages 
that you should be familiar with.

1.8. Related documents

1.9. Document revisions

Abbreviation Description

CAP Computer Aided Programming system (a tool used to 
configure, maintain and operate the protection and control 
IEDs)

CET Communication Engineering Tool

GUI Graphical User Interface

IED Intelligent Electronic Device (protection and control relay)

LN Logical node according to IEC 61850 standard

LON A communication protocol developed by Echelon

SCL Substation Configuration description Language

SPA ABB proprietary communication protocol used in 
substation automation

Name of the manual Document ID
SPA-ZC 400 Ethernet Adapter
Installation and Commissioning Manual

1MRS755347

SPA-ZC 402 Ethernet Adapter
Installation and Commissioning Manual

1MRS755380

Communication Gateway COM 610 *2.0 User�s 
Guide

1MRS755385

MicroSCADA Pro IEC 61850 Master Protocol (OPC) 
*1.1 User�s Guide

1MRS755321

IEC 61850 standard IEC 61850-6, -7-3, -7-4

Version Date History
A 15.10.2004 Document created
B 25.05.2005 Support for new IED (RET 541/543/545)

Additions: Chapter 4. Content and usage of 
connectivity packages and Chapter 5. Logical 
node naming. 

C 08.07.2005 Support for REF (Release 3.5)
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2. Installation and uninstallation

This chapter describes the installation and the uninstallation of the connectivity 
packages.

2.1. Installing connectivity packages

1. Locate the connectivity package installation program (.msi) from the computer 
or download it via Internet.

2. Double click the relevant IED connectivity package installation program to start 
the installation. The installation wizard extracts the installation files to your 
local computer.

3. After the connectivity package installation program starts, click Next to 
proceed, see Fig. 2.1.-1.

With the Back button you can return to the previous dialog, and with the 
Cancel button exit the installation wizard. This applies to all the dialogs in 
the installation wizard.

One connectivity package requires at least 55 MB of hard disk 
space, although the installation package size is about 30 MB.

Connectivity packages can be installed into the same environments 
as system products and tools that utilize the connectivity packages. 
For more information about the system products and tools manuals, 
refer to Section 1.8. Related documents.
11
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Fig. 2.1.-1 REF 541/543/545 Connectivity Package installation program

4. Follow the instructions of the installation wizard to complete the installation.
12
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2.2. Uninstalling connectivity packages
To uninstall the connectivity packages:

1. Open the Add or Remove Programs dialog from the Windows Control Panel.
2. Select the relevant connectivity package and click Remove, see Fig. 2.2.-1.

You can check that you are uninstalling the right connectivity package by 
clicking the support information link. A Support Info dialog is displayed to 
indentify the correct connectivity package version.

A050309

Fig. 2.2.-1 Add or Remove Programs dialog
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3. Connectivity Package Manager

The Connectivity Package Manager is a tool that helps you to associate the right 
connectivity package versions to different applications and tools. Connectivity 
Package Manager is included in products supporting the connectivity concept. For 
more information on the supported applications and tools, refer to Section 1.3. 
General and Section 1.8. Related documents.

A Connectivity Package Manager window shows the installed applications and 
tools, as well as the installed connectivity package versions in a tree structure, see 
Fig. 3.-1. The object tree shows all the information on the connectivity packages and 
the IED configuration tools that are installed on the computer. You can decide which 
version of the connectivity package associates with the specified application and 
tool by selecting the corresponding check box.

A050310

Fig. 3.-1 Connectivity Package Manager
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3.1. Starting Connectivity Package Manager
You can start the Connectivity Package Manager from the shortcut icon on your 
computer�s desktop, see Fig. 3.1.-1, or from the Tools menu of the corresponding 
tool.

A040149

Fig. 3.1.-1 Connectivity Package Manager icon

You can exit the program by selecting File > Exit.

3.2. Using Connectivity Package Manager
This section describes the main functions of the Connectivity Package Manager.

3.2.1. Associating connectivity package versions
When the Connectivity Package Manager is started, it shows all the applications and 
tools supporting connectivity concept, as well as the connectivity packages installed 
on your computer. You can expand and collapse the Connectivity Package 
Manager�s tree structure to see which connectivity package versions are currently 
used in the different applications and tools.

You can browse in the object tree with mouse or keyboard�s arrow keys. You can 
expand and collaps the nodes by clicking the  and  icons or pressing left and right 
arrow keys. You can also use the commands from the View menu to expand and 
collaps the nodes.

If the check box beside the version name is selected, the particular version of the 
connectivity package is used in the application or tool. If you clear all the versions 
of one connectivity package, the application or tool no longer uses that connectivity 
package the next time you start it. This will save some processing time during the 
application or tool startup.

If you have already installed some other connectivity packages, the Connectivity 
Package Manager detects them and checks if they can be used with the new IEDs. If 
the installed connectivity packages are from a wrong version extension, the 
Connectivity Package Manager prevents them to associate with the new IEDs.

To select the latest versions for all the installed connectivity packages select Set 
Latest > Set Latest Versions to All. The program goes through all the installed 
connectivity packages shown in the object tree and selects the most recent version 
for all of them, see Fig. 3.2.1.-1.
16
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A050311

Fig. 3.2.1.-1 Setting latest versions to all nodes

To select the latest version for only those connectivity packages which do not have 
any version selected, select Set Latest > Set Latest to Unchecked Packages. This 
command leaves the already selected connectivity package versions as they are, see 
Fig. 3.2.1.-2.

A050312

Fig. 3.2.1.-2 Setting latest versions to unactive nodes

If the connectivity package version has information about supported IEDs, this 
information is shown in the text box under Supported IEDs, see Fig. 3.2.1.-3. With 
this information you can confirm the right version of the connectivity package.

A050052

Fig. 3.2.1.-3 Specific IED�s supported versions

3.2.2. Adding connectivity packages
Connectivity packages can be installed to the local computer also with the 
Connectivity Package Manager. You can install connectivity packages from any 
location you have access to.

To add a new connectivity package:

1. Select File > Add new package. The Open dialog displays.
17
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Fig. 3.2.2.-1 Adding new connectivity package

A050314

Fig. 3.2.2.-2 Adding connectivity package

2. Select a relevant connectivity package installer file (.msi).
3. Click Open.

The installation program starts to install the selected connectivity package to your 
local computer. For more information about installing connectivity packages, refer 
to Chapter 2. Installation and uninstallation.
18
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4. Content and usage of connectivity packages

For all the products supporting the connectivity concept, the connectivity packages 
contain:

� Description of IED functionality and capabilities in SCL format. An IED 
functionality is mapped from the SPA and LON protocols to IEC 61850 protocol. 
The description texts in these files can be translated to other languages as well.

� Object types for device integration. These object types define the properties for a 
device related object, for example the protocols that are supported by IED.

� IED specific visual elements, for example object icons, graphical symbols and 
pictures in various places.

� Connectivity package related documentation
� IED specific documentation
� Other data and components needed by products using connectivity packages

The following sections describe the usage of connectivity packages in different 
products. For more information on how to use connectivity packages in applications 
and tools, refer to documentation related to each product.

Communication Gateway COM 610
You can use the connectivity packages to configure the Communication Gateway 
COM 610 with CET to communicate and interact with the SPA and LON devices. 
With the connectivity packages, you can also configure COM 610 by using IEC 
61850 protocol to a SPA device that uses SPA-ZC 40x.

Ethernet Adapter SPA-ZC 40x
You can use the connectivity packages to configure SPA-ZC 40x with CET for SPA-
ZC 400 and SPA-ZC 402. A combination of SPA-ZC 40x and COM 610 is also 
supported.

MicroSCADA Pro SYS 600 and COM 500
In the MicroSCADA Pro SYS 600 *9.0 or later and COM 500 *4.1 or later, you can 
use the connectivity packages to configure the IEC 61850 OPC server. This is 
usually done by importing the export file that is generated when SPA-ZC 40x is 
configured. In the MicroSCADA Pro SYS 600 *9.1 or later and COM 500 *4.2 or 
later, the same export file can be also used to build up the process database.
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5. Logical node naming

The connectivity packages contain the descriptions for logical nodes and function 
blocks of IEDs. When an IED configuration (SCL file or CAP project file) is 
imported to the connectivity package object, a structure containing definitions of 
logical nodes is constructed.

When the IED configuration is imported, for example, to the Communication 
Engineering Tool (CET), you can see the logical devices (LD) and logical nodes 
(LN). An IED object can include many logical devices, and a logical device can 
include many logical nodes.

The logical node names are constructed from three different parts: LN prefix, LN 
class and LN instance number. LN prefix is an ABB specific string with less than 
five characters (see the table below). The LN class is the name of the logical node 
class defined in the IEC 61850-7-4 specification, refer to the Section 1.8. Related 
documents. The LN instance number is the ID number of logical node. In the 
REF 541/543/545, REM 543/545 and RET 541/543/545 connectivity packages, the 
LN instance number is the SPA channel number of the corresponding function 
block.

The figure below shows a designation code for the logical nodes in connectivity 
packages. In the following example, the logical node name is DEFPTOC41.

A050046

Fig. 5.-1 Logical node naming in connectivity packages
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The following table presents the logical node prefixes for RED500 series IEDs.

Table 5.-1 LN prefixes for RED500

Function Block 
Name IEC 61850 Logical Node Name Description

Logical Node Prefix Logical Node Class
Logical Node 

Instance
(Channel Number)

Protection
AR5Func - RREC 80 Auto-reclosing function
CUB1Cap CUB PTOC 117 Unbalance protection for capacitors
CUB1Cap CUB RBRF 117 Circuit breaker failure protection of 

unbalance protection for capacitors
CUB3Cap CUB PTOC 52 Three-phase unbalance protection 

for capacitor banks
CUB3Cap CUB RBRF 52 Circuit breaker failure protection of 

three-phase unbalance protection 
for capacitor banks

CUB3Low CUB PTOC 51 Phase discontinuity protection
CUB3Low CUB RBRF 51 Circuit breaker failure protection of 

phase discontinuity protection
DEF2High DEF PTOC 41 Directional earth-fault protection 

function, high-set stage
DEF2High DEF RBRF 41 Circuit breaker failure protection of 

directional earth-fault protection 
function, high-set stage

DEF2Inst DEF PTOC 42 Directional earth-fault protection 
function, instantaneous stage

DEF2Inst DEF RBRF 42 Circuit breaker failure protection of 
directional earth-fault protection 
function, instantaneous stage

DEF2Low DEF PTOC 40 Directional earth-fault protection 
function, low-set stage

DEF2Low DEF RBRF 40 Circuit breaker failure protection of 
directional earth-fault protection 
function, low-set stage

Diff3 HIZ PDIF 100 High-impedance based differential 
protection for generators and 
motors

Diff3 HIZ RBRF 100 Circuit breaker failure protection of 
high-impedance based differential 
protection for generators and 
motors

Diff6G GEN PDIF 99 Stabilized three-phase differential 
protection for generators

Diff6G GEN RBRF 99 Circuit breaker failure protection of 
stabilized three-phase differential 
protection for transformers

DOC6High DIR PTOC 36 Three-phase directional 
overcurrent function, high-set stage

DOC6High DIR RBRF 36 Circuit breaker failure protection of 
three-phase directional overcurrent 
function, high-set stage
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DOC6Inst DIR PTOC 37 Three-phase directional 
overcurrent function, instantaneous 
stage

DOC6Inst DIR RBRF 37 Circuit breaker failure protection of 
three-phase directional overcurrent 
function, instantaneous stage

DOC6Low DIR PTOC 35 Three-phase directional 
overcurrent function, low-set stage

DOC6Low DIR RBRF 35 Circuit breaker failure protection of 
three-phase directional overcurrent 
function, low-set stage

FLOC LCTR RFLO 58 Fault locator
Freq1St1 T1 PTOF 72 Overfrequency protection stage 1, 

timer 1
Freq1St1 T1 PTUF 72 Underfrequency protection stage 1, 

timer 1
Freq1St1_1 T2 PTOF 72 Overfrequency protection stage 1, 

timer 2
Freq1St1_1 T2 PTUF 72 Underfrequency protection stage 1, 

timer 2
Freq1St1 - PFRC 72 Rate of change of frequency 

protection stage 1
Freq1St2 T1 PTOF 73 Overfrequency protection stage 2, 

timer 1
Freq1St2 T1 PTUF 73 Underfrequency protection stage 2, 

timer 1
Freq1St2_1 T2 PTOF 73 Overfrequency protection stage 2, 

timer 2
Freq1St2_1 T2 PTUF 73 Underfrequency protection stage 2, 

timer 2
Freq1St2 - PFRC 73 Rate of change of frequency 

protection stage 2
Freq1St3 T1 PTOF 74 Overfrequency protection stage 3, 

timer 1
Freq1St3 T1 PTUF 74 Underfrequency protection stage 3, 

timer 1
Freq1St3_1 T2 PTOF 74 Overfrequency protection stage 3, 

timer 2
Freq1St3_1 T2 PTUF 74 Underfrequency protection stage 3, 

timer 2
Freq1St3 - PFRC 74 Rate of change of frequency 

protection stage 3
Freq1St4 T1 PTOF 75 Overfrequency protection stage 4, 

timer 1
Freq1St4 T1 PTUF 75 Underfrequency protection stage 4, 

timer 1

Table 5.-1 LN prefixes for RED500  (Continued)

Function Block 
Name IEC 61850 Logical Node Name Description

Logical Node Prefix Logical Node Class
Logical Node 

Instance
(Channel Number)
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Freq1St4_1 T2 PTOF 75 Overfrequency protection stage 4, 
timer 2

Freq1St4_1 T2 PTUF 75 Underfrequency protection stage 4, 
timer 2

Freq1St4 - PFRC 75 Rate of change of frequency 
protection stage 4

Freq1St5 T1 PTOF 76 Overfrequency protection stage 5, 
timer 1

Freq1St5 T1 PTUF 76 Underfrequency protection stage 5, 
timer 1

Freq1St5_1 T2 PTOF 76 Overfrequency protection stage 5, 
timer 2

Freq1St5_1 T2 PTUF 76 Underfrequency protection stage 5, 
timer 2

Freq1St5 - PFRC 76 Rate of change of frequency 
protection stage 5

FuseFail - RFUF 118 Fuse failure supervision
Inrush3 INR PHAR 34 Three-phase transformer inrush 

and motor start-up current detector
MotStart - PMSS 54 Three-phase start-up supervision 

for motors, starting time supervision
MotStart - PMRI 54 Three-phase start-up supervision 

for motors, restart inhibition
NEF1High EF PTOC 39 Non-directional earth-fault 

protection function, high-set stage
NEF1High EF RBRF 39 Circuit breaker failure protection of 

non-directional earth-fault 
protection function, high-set stage

NEF1Inst EF PTOC 90 Non-directional earth-fault 
protection function, instantaneous 
stage

NEF1Inst EF RBRF 90 Circuit breaker failure protection of 
non-directional earth-fault 
protection function, instantaneous 
stage

NEF1Low EF PTOC 38 Non-directional earth-fault 
protection function, low-set stage

NEF1Low EF RBRF 38 Circuit breaker failure protection of 
non-directional earth-fault 
protection function, low-set stage

NOC3High PH PTOC 32 Three-phase non-directional 
overcurrent function, high-set stage

NOC3High PH RBRF 32 Circuit breaker failure protection of 
three-phase non-directional 
overcurrent function, high-set stage

Table 5.-1 LN prefixes for RED500  (Continued)

Function Block 
Name IEC 61850 Logical Node Name Description

Logical Node Prefix Logical Node Class
Logical Node 

Instance
(Channel Number)
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NOC3Inst PH PTOC 33 Three-phase non-directional 
overcurrent protection function, 
instantaneous stage

NOC3Inst PH RBRF 33 Circuit breaker failure protection of 
three-phase non-directional 
overcurrent protection function, 
instantaneous stage

NOC3Low PH PTOC 31 Three-phase non-directional 
overcurrent function, low-set stage

NOC3Low PH RBRF 31 Circuit breaker failure protection of 
three-phase non-directional 
overcurrent function, low-set stage

NPS3High NS PTOC 78 Negative phase sequence 
protection, high-set stage

NPS3High NS RBRF 78 Circuit breaker failure protection of 
negative phase sequence 
protection, high-set stage

NPS3Low NS PTOC 77 Negative phase sequence 
protection, low-set stage

NPS3Low NS RBRF 77 Circuit breaker failure protection of 
negative phase sequence 
protection, low-set stage

NUC3St1 PH PTUC 88 Three-phase non-directional 
undercurrent protection, stage 1

NUC3St1 PH RBRF 88 Circuit breaker failure protection of 
three-phase non-directional 
undercurrent protection, stage 1

NUC3St2 PH PTUC 89 Three-phase non-directional 
undercurrent protection, stage 2

NUC3St2 PH RBRF 89 Circuit breaker failure protection of 
three-phase non-directional 
undercurrent protection, stage 2

OE1High - PVPH 69 Overexcitation protection, high-set 
stage

OE1High - RBRF 69 Circuit breaker failure protection of 
overexcitation protection, high-set 
stage

OE1Low - PVPH 68 Overexcitation protection, low-set 
stage

OE1Low - RBRF 68 Circuit breaker failure protection of 
Overexcitation protection, low-set 
stage

OL3Cap OLC PTOC 116 Three-phase overload protection 
for capacitors

OL3Cap OLC PTUC 116 Undercurrent protection for 
capacitor banks

Table 5.-1 LN prefixes for RED500  (Continued)

Function Block 
Name IEC 61850 Logical Node Name Description

Logical Node Prefix Logical Node Class
Logical Node 

Instance
(Channel Number)
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OL3Cap OLC RBRF 116 Circuit breaker failure protection of 
three-phase overload protection for 
capacitors

OPOW6St1 PH PDIR 92 Three-phase directional overpower, 
stage 1

OPOW6St1 PH PDOP 92 Directional overpower
OPOW6St1 PH RBRF 92 Breaker failure
OPOW6St2 PH PDIR 93 Three-phase directional overpower, 

stage 2
OPOW6St2 PH PDOP 93 Directional overpower
OPOW6St2 PH RBRF 93 Breaker failure
OPOW6St3 PH PDIR 94 Three-phase directional overpower, 

stage 3
OPOW6St3 PH PDOP 94 Directional overpower
OPOW6St3 PH RBRF 94 Breaker failure
OV3High PH PTOV 63 Three-phase overvoltage 

protection, high-set stage
OV3Low PH PTOV 62 Three-phase overvoltage 

protection, low-set stage
PREV3 PRV PPAM 55 Phase reversal protection
PSV3St1 NS PTOV 112 Negative phase sequence 

overvoltage
PSV3St1 PS PTUV 112 Positive phase sequence 

undervoltage
PSV3St1_1 PS PTOV 112 Positive phase sequence 

overvoltage
PSV3St2 NS PTOV 113 Negative phase sequence 

overvoltage
PSV3St2 PS PTUV 113 Positive phase sequence 

undervoltage
PSV3St2_1 PS PTOV 113 Positive phase sequence 

overvoltage
REF1A REF PDIF 102 High-impedance based restricted 

earth-fault protection
REF1A REF RBRF 102 Circuit breaker failure protection of 

high-impedance based restricted 
earth-fault protection

ROV1High RES PTOV 45 Residual overvoltage protection, 
high-set stage

ROV1Inst RES PTOV 46 Residual overvoltage protection, 
instantaneous stage

ROV1Low RES PTOV 44 Residual overvoltage protection, 
low-set stage

SCVST1 - RSYN 70 Synchro-check/voltage check 
function stage 1

Table 5.-1 LN prefixes for RED500  (Continued)

Function Block 
Name IEC 61850 Logical Node Name Description

Logical Node Prefix Logical Node Class
Logical Node 

Instance
(Channel Number)
26



1MRS755312 REF 541/543/545
REM 543/545

RET 541/543/545

Connectivity Packages

User�s Guide
SCVST2 - RSYN 71 Synchro-check/voltage check 
function stage 2

TOL3Cab CAB PTTR 47 Three-phase thermal overload 
protection for cables

TOL3Dev DEV PTTR 48 Three-phase thermal overload 
protection for devices

UE6High - PDIR 67 Three-phase underexcitation 
protection, high-set stage

UE6High - PDUP 67 Directional underpower of three-
phase underexcitation protection, 
high-set stage

UE6High - RBRF 67 Circuit breaker failure of three-
phase underexcitation protection, 
high-set stage

UE6Low UE PDIS 66 Three-phase underexcitation 
protection, low-set stage

UI6High - PDIS 111 Three-phase underimpedance 
protection, high-set stage

UI6High - RBRF 111 Circuit breaker failure of three-
phase underimpedance protection, 
high-set stage

UI6Low UI PDIS 110 Three-phase underimpedance 
protection, low-set stage

UI6Low UI RBRF 110 Circuit breaker failure of three-
phase underimpedance protection, 
low-set stage

UPOW6St1 PH PDIR 95 Three-phase underpower or 
reverse power, stage 1

UPOW6St1 PH PDUP 95 Directional underpower
UPOW6St1 PH RBRF 95 Circuit breaker failure of three-

phase underpower or reverse 
power, stage 1

UPOW6St2 PH PDIR 96 Three-phase underpower or 
reverse power, stage 2

UPOW6St2 PH PDUP 96 Directional underpower
UPOW6St2 PH RBRF 96 Circuit breaker failure of three-

phase underpower or reverse 
power, stage 2

UPOW6St3 PH PDIR 97 Three-phase underpower or 
reverse power, stage 3

UPOW6St3 PH PDUP 97 Directional underpower
UPOW6St3 PH RBRF 97 Circuit breaker failure of three-

phase underpower or reverse 
power, stage 3

UV3High PH PTUV 65 Three-phase undervoltage 
protection, high-set stage
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UV3Low PH PTUV 64 Three-phase undervoltage 
protection, low-set stage

VOC6High - PVOC 107 Voltage controlled/dependent time 
overcurrent

VOC6High - RBRF 107 Circuit breaker failure of voltage 
controlled/dependant time 
overcurrent

VOC6Low PH PVOC 91 Voltage dependent overcurrent 
protection, low-set stage (51V)

VOC6Low PH RBRF 91 Circuit breaker failure of voltage 
dependent overcurrent protection, 
low-set stage

NOC3LowB PH PTOC 53 Three-phase non-directional 
overcurrent function, low-set stage

NOC3LowB PH RBRF 53 Circuit breaker failure protection of 
three-phase non-directional 
overcurrent function, low-set stage

REF4A REF PDIF 101 Stabilized restricted earth-fault 
protection, high voltage side

REF4A REF RBRF 101 Circuit breaker failure protection of 
stabilized restricted earth-fault 
protection, high voltage side

REF4B REF PDIF 119 Stabilized restricted earth-fault 
protection, low voltage side

REF4B REF RBRF 119 Circuit breaker failure protection of 
stabilized restricted earth-fault 
protection, low voltage side

Diff6T GEN PDIF 106 Stabilized three-phase differential 
protection for transformers

Diff6T GEN RBRF 106 Circuit breaker failure protection of 
stabilized three-phase differential 
protection for transformers

Control
CO3DC1 DCO3 CILO 139 Three state disconnector 1, 

interlocking
CO3DC1 DCO3 CSWI 139 Three state disconnector 1, switch 

control
CO3DC1 DCO3 XSWI 139 Three state disconnector 1, 

disconnector information
CO3DC1_1 ESW3 CILO 139 Three state disconnector 1, 

interlocking
CO3DC1_1 ESW3 CSWI 139 Three state disconnector 1, switch 

control
CO3DC1_1 ESW3 XSWI 139 Three state disconnector 1, 

disconnector information
CO3DC2 DCO3 CILO 140 Three state disconnector 2, 

interlocking
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CO3DC2 DCO3 CSWI 140 Three state disconnector 2, switch 
control

CO3DC2 DCO3 XSWI 140 Three state disconnector 2, 
disconnector information

CO3DC2_1 ESW3 CILO 140 Three state disconnector 1, 
interlocking

CO3DC2_1 ESW3 CSWI 140 Three state disconnector 2, switch 
control

CO3DC2_1 ESW3 XSWI 140 Three state disconnector 2, 
disconnector information

COCB1 CB CILO 120 Circuit breaker 1, interlocking
COCB1 CB CSWI 120 Circuit breaker 1, switch control
COCB1 CB XCBR 120 Circuit breaker 1, circuit breaker 

information
COCB2 CB CILO 121 Circuit breaker 2, interlocking
COCB2 CB CSWI 121 Circuit breaker 2, switch control
COCB2 CB XCBR 121 Circuit breaker 2, circuit breaker 

information
CODC1 DCO CILO 122 Disconnector 1, interlocking
CODC1 DCO CSWI 122 Disconnector 1, switch control
CODC1 DCO XSWI 122 Disconnector 1, disconnector 

information
CODC2 DCO CILO 123 Disconnector 2, interlocking
CODC2 DCO CSWI 123 Disconnector 2, switch control
CODC2 DCO XSWI 123 Disconnector 2, disconnector 

information
CODC3 DCO CILO 124 Disconnector 3, interlocking
CODC3 DCO CSWI 124 Disconnector 3, switch control
CODC3 DCO XSWI 124 Disconnector 3, disconnector 

information
CODC4 DCO CILO 125 Disconnector 3, interlocking
CODC4 DCO CSWI 125 Disconnector 3, switch control
CODC4 DCO XSWI 125 Disconnector 3, disconnector 

information
CODC5 DCO CILO 126 Disconnector 5, interlocking
CODC5 DCO CSWI 126 Disconnector 5, switch control
CODC5 DCO XSWI 126 Disconnector 5, disconnector 

information
COIND1 ESW CSWI 127 Switch controller
COIND1 ESW XSWI 127 Object indication 1, non-

controllable
COIND2 ESW CSWI 128 Switch controller
COIND2 ESW XSWI 128 Object indication 2, non-

controllable
COIND3 ESW CSWI 129 Switch controller
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COIND3 ESW XSWI 129 Object indication 3, non-
controllable

COIND4 ESW CSWI 130 Switch controller
COIND4 ESW XSWI 130 Object indication 4, non-

controllable
COIND5 ESW CSWI 131 Switch controller
COIND5 ESW XSWI 131 Object indication 5, non-

controllable
COIND6 ESW CSWI 132 Switch controller
COIND6 ESW XSWI 132 Object indication 6, non-

controllable
COIND7 ESW CSWI 133 Switch controller
COIND7 ESW XSWI 133 Object indication 7, non-

controllable
COIND8 ESW CSWI 134 Switch controller
COIND8 ESW XSWI 134 Object indication 8, non-

controllable
COPFC PFC ARCO 143 Power factor controller

Condition Monitoring
CMBWEAR1 CBEW GGIO 187 Circuit breaker electric wear 1
CMBWEAR2 CBEW GGIO 188 Circuit breaker electric wear 2
CMCU3 SCC GGIO 181 Supervision function of the 

energizing current input circuit
CMGAS1 - SIMG 186 Gas density monitoring
CMGAS3 - SIMG 194 Gas density monitoring of three 

poles
CMSHED CHED GGIO 189 Scheduled maintenance
CMSPRC1 SPRC GGIO 190 Spring charging control 1
CMTCS1 TCS GGIO 191 Trip circuit supervision 1
CMTCS2 TCS GGIO 192 Trip circuit supervision 2
CMTIME1 T GGIO 184 Operate time counter 1 for the used 

operate time (motors)
CMTIME2 T GGIO 185 Operate time counter 2 for the used 

operate time (motors)
CMTRAV1 TRT GGIO 193 Breaker travel time 1 supervision
CMVO3 SVC GGIO 182 Supervision of the energizing 

voltage input circuit

Measurement
MEAI1 GM GGIO 213 General measurement 1
MEAI2 GM GGIO 214 General measurement 2
MEAI3 GM GGIO 215 General measurement 3
MEAI4 GM GGIO 216 General measurement 4
MEAI5 GM GGIO 217 General measurement 5
MEAI6 GM GGIO 218 General measurement 6
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MEAI7 GM GGIO 219 General measurement 7
MEAI8 GM GGIO 220 General measurement 8
MECU1A I MMXU 201 Current measurement A
MECU1B I MMXU 203 Current measurement B
MECU3A I MMXU 200 Three-phase current measurement 

A
MECU3B I MMXU 202 Three-phase current measurement 

B
MEDREC - RDRE 225 Transiet disturbance recorder
MEFR1 F MMXU 208 System frequency measurement
MEPE7 W MMTR 207 Three-phase energy metering
MEPE7 P MMXU 207 Three-phase power metering
MEVO1A U MMXU 205 Voltage measurement A
MEVO1B U MMXU 226 Voltage measurement B
MEVO3A U MMXU 204 Three-phase voltage measurement 

A
MEVO3B U MMXU 206 Three-phase voltage measurement 

B

Power Quality
PQCU3H PQ MHAI 512 Current waveform distortion 

measurement
PQVO3H PQ MHAI 513 Voltage waveform distortion 

measurement
PQVO3SD UV QVVR 514 Short duration voltage variations
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